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Communications regulation information

FCC statement
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to
radio or television reception is suspected.  

Radio and television interference
The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception.  

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation.  

You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices.  

If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:  
m Turn the television or radio antenna until the interference stops.  
m Move the computer to one side or the other of the television or radio.  
m Move the computer farther away from the television or radio.  
m Plug the computer into an outlet that is on a different circuit from the television or radio.

(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.)  

If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions. You may find the following booklet helpful: Interference
Handbook  (stock number 004-000-00493-1). This booklet, prepared by the Federal
Communications Commission, is available from the U.S. Government Printing Office,
Washington, DC 20402.  

IMPORTANT  Changes or modifications to this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance.  
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DOC statement
DOC Class B Compliance  This digital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus as set out in the interference-causing equipment standard
entitled “Digital Apparatus,” ICES-003 of the Department of Communications.  

Observation des normes—Classe B  Cet appareil numérique respecte les limites de bruits
radioélectriques applicables aux appareils numériques de Classe B prescrites dans la norme 
sur le matériel brouilleur : “Appareils Numériques”, NMB-003 édictée par le ministre des
Communications.  

CD-ROM drive laser information
WARNING Making adjustments or performing procedures other than those specified in your
equipment’s manual may result in hazardous exposure.

WARNING Do not attempt to disassemble the cabinet containing the laser. The laser beam used in
this product is harmful to the eyes. The use of optical instruments, such as magnifying lenses,
with this product increases the potential hazard to your eyes. For your safety, have this
equipment serviced only by an Apple-authorized service provider. 

Your computer is a Class 1 laser product. The Class 1 label, located on the computer, indicates
that the CD-ROM drive meets minimum safety requirements. A service warning label is on the
CD-ROM drive. 

Class 1 label
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Your internal CD-ROM (Compact Disc Read-Only Memory) player for
Macintosh computers works with CD-ROM discs, standard audio compact
discs (CDs), and single-session or multisession Photo CDs. Your CD-ROM
player provides access to large amounts of information. However, you cannot
save information on CD-ROM discs. ROM stands for “read-only memory,”
meaning that the player cannot “write” information onto CD-ROM discs.

A wide selection of CD-ROM discs is available for entertainment, education,
and business. A typical disc can hold over 650 megabytes (MB) of
information—the equivalent of 270,000 pages of text, up to eight hours 
of speech or music (depending on the sound quality), hundreds of high-
resolution images, or any combination of text, sound, and graphics. 
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Types of compact discs you can use

Not all CD-ROM discs store information in the same way. A disc stores and
displays information according to a given file format. Your computer’s system
software must understand the file format in order to use the contents of the
disc. 

Standard file formats

You can use CD-ROM discs with these standard file formats:

m HFS (Hierarchical File System)—the standard format used by the
Macintosh.

m ISO 9660—the International Standards Organization’s file format for 
CD-ROM discs. This format has been adopted by many CD manufacturers
to make their discs compatible with a variety of computers. It is also the
format that allows you to use Photo CDs in your CD-ROM player.

m The High Sierra format, a predecessor of the ISO 9660 format.

Software that lets you use discs with these file formats is probably already
installed on your computer. To check whether the software is installed, see 
“Is Your CD-ROM Software Already Installed?” later in this chapter.

Other CD-ROM formats

Your CD-ROM player also works with file formats other than the ones listed
above (for example, CD-ROM XA), provided that you install the appropriate
software on your Macintosh. See the Appendix for more detailed information
on formats, or modes, supported by your CD-ROM player. To find out about
the availability of Macintosh software for additional file formats, contact the
publisher of a particular disc.

Audio CDs

Your CD-ROM player can play audio CDs and audio tracks on CD-ROM
discs using your computer’s built-in speaker. You can also attach headphones
or speakers to your computer for stereo sound. For further information, see
Chapter 2, “Playing Audio Compact Discs and Audio Tracks on CD-ROM
Discs.”

2 Chapter  1



Photo CDs

With your CD-ROM player, you can open digitized images stored on Photo
CDs. 

To view Photo CD images, you need QuickTime version 1.6.1 or later. To
check the version of QuickTime, locate its icon (in the Extensions folder
inside your System Folder), click the icon to select it, then choose Get Info
from the File menu. The version number appears in the Info window. 

If you need to install QuickTime, follow the instructions in Chapter 4. For
further information on Photo CDs, see Chapter 3, “Working With Photo CD
Images.”

Is your CD-ROM software already installed?

In most cases, all the software required for using your CD-ROM player is
already installed on your computer and is ready to use.

To determine whether CD-ROM software is installed, pull down the
Apple (K) menu.

If AppleCD Audio Player appears in the menu, then the CD-ROM software has
already been installed.

If AppleCD Audio Player does not appear, you need to install the CD-ROM
software.

If your CD-ROM player came with your computer, first check the user’s guide
that came with your computer (if you are a system administrator, check the
administrator’s guide that came with your server). If it contains instructions
on installing CD-ROM software, use those instructions instead of the
instructions in this manual.

If you purchased your CD-ROM player separately, turn to Chapter 4 of this
manual for instructions on installing the software.
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Inserting and ejecting discs

Your CD-ROM player uses a tray to hold a CD-ROM disc in place while a
laser reads information from the disc.

Inserting a disc

Follow these instructions to insert a CD-ROM disc into your CD-ROM
player. Then follow the instructions that came with your disc to use the disc.

1 Start up your Macintosh computer, if it’s not already on.

2 Press the Open/Close button to open the tray of the CD-ROM player.

3 Place a CD-ROM disc in the tray, with the disc label facing up.

Make sure the disc is lying flat and centered in the tray. If you are using a
small (8 cm) disc, make sure it is centered within the inside ring on the tray.

Open/Close button
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4 Push the tray in, or press the Open/Close button, to close the tray.

In a few moments, an icon for the CD-ROM disc appears on your screen.

Ejecting a disc

Follow these instructions to open the tray and eject a CD-ROM disc from
your computer.

IMPORTANT  With some versions of the file-sharing software (for sharing items
over a network), you cannot eject a disc if file sharing is turned on. To turn
off file sharing, see the documentation or on-screen help that came with your
computer.

1 Open the tray.

There are several ways to open the tray of your CD-ROM player.

If a CD-ROM disc icon appears on your screen:

m Select the disc icon and drag the icon to the Trash.

m Click the disc icon, then choose Put Away from the File menu.

m While the AppleCD Audio Player window is active, choose Eject CD from
the File menu, or press x-E.

If no CD-ROM disc icon appears on your screen:

m Press the Open/Close button for your CD-ROM player (on the front of the
computer’s case).

IMPORTANT  If you have difficulty opening the tray, see “Problems Using 
CD-ROM Discs” in Chapter 5.

2 Take the CD-ROM disc out of the tray.

Store your disc in a safe place, away from heat, dust, and moisture.
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3 Push the tray in, or press the Open/Close button, to close the tray.

To avoid damage to the tray or the CD-ROM player, keep the tray closed when
you are not using it.

The CD-ROM player tray automatically closes when you shut down your
computer. You may want to remove a CD-ROM disc from the tray before
shutting down. Otherwise, the computer may try to start up from the disc the
next time you turn on the computer. For more information, see “Problems
Starting Up Your Computer” in Chapter 5.

Care and handling 

Keep these important safety instructions in mind as you use your CD-ROM
player.

m Position your computer so that the tray doesn’t bump into anything when it
opens.

m Do not leave the disc tray open. If dust gets on the lens of the CD-ROM
player, the player may have problems reading your compact discs.

m Do not put anything (for instance, a cup) on top of the tray when it is open.

m Do not force the tray open by hand.

m Do not wipe the lens with a paper towel or other abrasive surface. If you
need to clean the lens, see an Apple-authorized service provider for a lens
cleaner. 

m Do not transport your computer while a disc is inside the CD-ROM player.

m Keep your computer equipment away from any source of liquid (such as
wash basins, bathtubs, and shower stalls). If you drink coffee or other
beverages while you’re at your computer, take care not to spill.

m Avoid exposing your equipment to damp or wet weather. If your system is
near a window, be sure the window is closed in rainy weather.

WARNING  Electrical equipment may be hazardous if misused. Operation
of this product, or similar products, must always be supervised by an
adult. Do not allow children access to the interior of any electrical
product and do not permit them to handle cables.
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Keep these important safety instructions in mind as you use CD-ROM discs:

m Hold a disc by the edges or by one edge and the center hole. Do not touch
the disc surface.

m To clean discs, wipe the shiny surface with a soft, damp cloth, working in
straight lines from center to edge. Do not use any form of cleaning agent.

m To avoid damage to your discs, follow these guidelines:

m Keep these instructions handy for reference.

m Follow all instructions and warnings concerning your system.

Sharing a CD-ROM disc over a network

You can share a CD-ROM disc using file sharing. If the disc has audio
portions, you will be able to hear the audio yourself, but other people on the
network will not. Likewise, you cannot hear the audio portions of discs you
access over a network.

For further information about file sharing, see the documentation or on-
screen help that came with your computer.

Do not put tape

on discs.

Do not scratch

discs.

Do not write on

discs.

Do not spill liquids

on discs.

Do not get

dust on discs.

Do not expose discs

to direct sunlight.

7Set t ing Up and Using Your  CD-ROM Dr ive





9

With your CD-ROM player and your computer’s built-in speaker, you can play
audio compact discs (CDs) or audio tracks on CD-ROM discs. You can also
attach headphones or speakers to the computer to listen to audio. See the
manuals that came with your computer for information on connecting sound
equipment.

Your CD-ROM player comes with a program called AppleCD Audio Player
that lets you start, stop, and otherwise control your CDs. You can also listen to
audio in the background while you do other work on your computer. Before
you use the Audio Player, make sure that the compact disc you’re using
contains audio information.

Starting up the AppleCD Audio Player

To get ready to play an audio CD, follow these steps:

1 Place an audio CD (or a CD-ROM disc with audio tracks) in the tray, with the disc label
facing up.

If you are using a small (8 cm) disc, make sure it is centered in the tray’s
inner ring.

2 Push the tray in, or press the Open/Close button, to close the tray.

In a few moments, the disc icon appears on your screen. An audio CD icon
has the name Audio CD and a number. The icon of a CD-ROM disc shows
the name of the disc.
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3 Open the Apple (K) menu and choose AppleCD Audio Player.

The AppleCD Audio Player window appears.

If AppleCD Audio Player does not appear in the menu, you need to install
CD-ROM software on your Macintosh. See Chapter 4 of this manual.

Using the AppleCD Audio Player

The AppleCD Audio Player looks and works like a typical audio CD player.
When you place a CD in the CD-ROM drive, the Audio Player sets it to begin
with Track 1. You click the Play/Pause button to begin playing the CD. If you
want to select a particular track, you click the Track buttons. As the disc plays,
the Audio Player shows the current track and time information.

The Audio Player window must be open if you want to start or stop play,
change tracks, or otherwise control play. However, play continues when you
close the Audio Player window.
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Basic controls

Track and time display/Clock button

Shows the track currently being played and time information. There are
several time options: Track Elapsed Time, Track Remaining Time, Disc
Elapsed Time, and Disc Remaining Time. To change the time display, press
the Clock ( ) button. In the pop-up menu that appears, choose an option.
The current option has a checkmark beside it. 

Stop

Stops play and resets the track number to 1. 

Keyboard alternative:  Press the Delete key or Clear key to stop play.

Play/Pause

Starts or pauses play. Clicking Play (the button with a single arrow on it)
starts play at the beginning of the current track, or resumes play if the Pause
button has been clicked. When the CD is playing, the button changes to Pause
(displaying two small bars), and clicking it pauses play.

Keyboard alternative: Press the Space bar or Enter key to play or pause 
a track.
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Previous track Scan forward

Track and 
time display

Clock button Stop button Play/Pause button

Eject button



Eject

Stops play and ejects the CD. 

Keyboard alternative:  Press x-E to eject the disc.

Volume control

Adjusts the volume for the computer’s built-in speaker or for headphones or
speakers attached to the computer. Drag the slider up to increase volume and
down to decrease it. 

Keyboard alternative:  Press the Up Arrow key to increase volume and the
Down Arrow key to decrease volume.

Scan backward and forward

Moves rapidly backward or forward through a track. You can hear the track as
it scans.

Previous and next track

Moves to the beginning of the previous or next track. 

Keyboard alternative:  Press the Left Arrow key to move to the previous track
and the Right Arrow key to move to the next track.

Keyboard alternatives

Button Keyboard alternative

Stop Delete  or Clear

Play/Pause Space bar or Enter 

Eject x-E 

Volume control Up Arrow (increase) and Down Arrow (decrease)

Previous track Left Arrow

Next track Right Arrow 
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Additional controls

Tracks pop-up menu

Allows you to quickly select and play a track. Press to open the Tracks pop-up
menu; when you choose a track, play begins immediately. (The current track
has a checkmark next to it.)

Repeat

Plays the CD continuously. When the button shows an arrow, click it to set the
CD to repeat. When the button shows a loop, click it to turn off repeating (the
CD will play until the end of the last track, and then stop).

Playing modes

You can play audio in one of three modes. To select a mode, click the button
for the one you want. An indicator light shows the current mode.

m Normal plays tracks in order (1, 2, 3, and so on). 

m Shuffle plays tracks in random order. 

m Program allows you to choose the order for audio tracks. For more
information, see “Creating a Play List,” later in this chapter.

Playing modes Repeat

Tracks pop-up menu

Close box

Track Edit button



Track Edit button

Displays the Track Edit window, which shows the the name of the disc and
the title, time, and order of tracks. 

You can make certain changes to the information in the Track Edit window,
depending on the playing mode selected. The Audio Player automatically
saves and remembers your changes the next time you use that disc.

m In Normal and Shuffle modes, you can change the track and CD titles, but
you can’t change the order of tracks.

m In Program mode, you can change the order of tracks and the title of the
CD, but you can’t change the track titles.

To close the Track Edit window, click the upward-pointing Track Edit button.

Close box

Closes the AppleCD Audio Player. Play continues when the Audio Player is
closed.

Options menu

You can adjust some features of the AppleCD Audio Player using the Options
menu. Each menu item in the Options menu opens a submenu. In the
submenu, the current option is indicated by a checkmark.

m Window color lets you choose a color for the Audio Player window.

m Indicator color lets you choose the color of the indicator lights.

m Sound lets you can change the way you hear the audio. You can choose left
channel only, right channel only, or stereo. This setting affects the built-in
speaker, external speakers, or headphones.

m StartUp CD Drive lets you select which CD-ROM player (if you have more
than one) to use with the AppleCD Audio Player. You choose the CD-ROM
player’s SCSI ID number in the submenu that appears.You must close or
quit and reopen the Audio Player for the change to take effect. 
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Creating a Play List

You can create a customized Play List for any CD that contains audio tracks.
You choose the tracks you want to play and the sequence in which to hear
them. To create a customized Play List:

1 Click the Program button (labeled PROG).

2 Click the Track Edit button.

The Track Edit window for the Program mode appears.

3 Drag tracks from the Track List at left to the Play List at right. 

Tracks are played in the order they appear in the Play List. 

To remove a track from the Play List, drag it back to the Track List.

4 If desired, rearrange the tracks in the Play List by dragging them to new positions.
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Track Edit button

The total playing time of
tracks on your Play List

Drag the tracks you
want from this list to
the Play List at right.

The indicator light
shows you are in

Program mode. 

Tracks on the Play List
appear in the order they
will be played.

Tracks on the Play ListAudio tracks on the CD

The name of the
audio CD icon. (You

can change it by
clicking the name and

typing a new name.)



5 Click the Track Edit button to close the Track Edit window.

The Play List you create is automatically saved (in the CD Remote Programs
file, in the Preferences folder inside the System Folder). The next time you
use this CD in the Program mode, your Play List will be displayed.

To play a customized Play List:

1 Insert a CD for which you created a Play List.

2 Choose AppleCD Audio Player from the Apple (K) menu.

3 Click the Program button to select Program mode.

4 Click the Play/Pause button.

You will hear the tracks in the order they appear on your Play List.

Another way to play audio tracks

If you open the icon for an audio CD or a CD-ROM disc with audio tracks,
you see audio track icons labeled Track 1, Track 2, and so on. If you select a
track icon and choose Get Info from the File menu, you see the track’s
playing time. You can play a track by opening its track icon.

m Double-click a track icon to start playing it.

IMPORTANT  If you drag an audio track icon to a floppy disk or hard disk, the
icon is copied but the copy isn’t usable. However, you can copy audio tracks
using a program that supports QuickTime, such as MoviePlayer.

Closing the AppleCD Audio Player

You can close the AppleCD Audio Player and continue with other work on
your computer while the CD plays. There are several ways to close the Audio
Player: 

m Click the close box in the upper-left corner of the Audio Player window.

m Choose Close from the File menu, or press x-W.

m Choose Quit from the File menu, or press x-Q.

When you want to turn off the CD, change tracks, or change CDs, open the
AppleCD Audio Player from the Apple (K) menu and make the necessary
changes.
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You can use your CD-ROM player to display Photo CD images stored on
Photo CDs. A Photo CD image is a digitized photograph that you can open
and view on your computer screen. 

17
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Obtaining Photo CDs

Your own photographs can be recorded as images on a Photo CD. To obtain a
Photo CD of your own photographs, take your 35-mm film to a photofinisher
who has a Photo CD system. The photofinisher develops your film, digitizes
the photographs, and gives you back a Photo CD containing your images. 

A single Photo CD can hold approximately a hundred images. If your Photo
CD isn’t full, you can take it back to the photofinisher and have more photos
added until the disc is full. Such discs are called multisession discs. Your CD-
ROM player can read both single-session and multisession Photo CDs. (Some
older CD-ROM players can read only single-session discs or only one session
of a multisession disc.)

Using Photo CDs

You can do many things with the images on your Photo CDs:

m Open and view the images individually on your computer screen. (See
“Viewing the Contents of a Photo CD,” later in this chapter.)

m View the images on your computer screen one after another, as you would
view a slide presentation. (See “Viewing Several Images in Sequence.”)

m Copy and save the images, print them, paste them into other documents
that accept graphics, and edit them with graphics programs. (See “Working
With Photo CD Images in Other Programs.”)

Photo CD images are excellent for desktop publishing, multimedia
presentations, business documents, and professional-quality graphic design.

IMPORTANT  To view Photo CD images, you need QuickTime version 1.6.1 or
later. To check the version of QuickTime, locate its icon (in the Extensions
folder inside your System Folder), click the icon to select it, then choose Get
Info from the File menu. The version number appears in the Info window. If
you need to install QuickTime, follow the instructions in Chapter 4.
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Viewing the contents of a Photo CD

When you double-click a Photo CD file, it is opened by the TeachText or
SimpleText program, unless you select another program to open Photo CD
images. See “Setting Preferences for How Photo CD Images are Displayed”
later in this chapter. 

IMPORTANT  If you plan to use TeachText or SimpleText to view Photo CD
images or other large files, you should use the program’s Info window to
assign it more memory. For instructions on assigning memory to a program,
see the documentation or on-screen help that came with your computer.

To view images on a Photo CD:

1 Insert a Photo CD in the CD-ROM player’s tray, with the disc label facing up.

2 Close the tray.

The first time you insert a particular Photo CD, a message appears telling you
the system is creating icons. These icons are tiny representations of the photo
CD’s contents. Click Stop if you want to use generic document icons instead. 

After a few moments, an icon for the Photo CD appears on the desktop. The
disc name has the letters “PCD” and an identifying number supplied by the
photofinisher. You cannot change the name of the disc.

By the way:  If you choose generic document icons and later decide you want
Photo CD icons instead, you can create them by pressing x-Option as you
insert the Photo CD. Continue holding down the keys until the disc icon
appears.
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3 Double-click the disc icon to open the Photo CD window.

A Photo CD window always contains a Slide Show, the Slide Show Viewer,
and a Photos folder. The Slide Show is a QuickTime movie that contains all
your images. (See “Viewing Several Images in Sequence,” later in this
chapter, for more information.) The Photos folder holds your individual
images.

The Photo CD window also contains a PHOTO_CD folder that holds
technical information about your Photo CD images. Normally, you won’t need
to use this folder.

4 Double-click the Photos folder to open it.

The Photos folder contains five folders. Each folder contains all your Photo
CD images recorded at a particular resolution. (See “A Note About
Resolution” later in this chapter.)
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5 Double-click the folder for the resolution you want.

Within the folder, an icon appears for each Photo CD image. Each icon is a
tiny representation of the image the file contains. The image numbers
correspond to the index that comes with your Photo CD.

IMPORTANT  When your system is low on memory, your computer may not be
able to display color icons for your Photo CD images; however, the images
themselves are not affected. To see the color icons, quit all open programs,
restart your computer, and then reopen the Photos folder. See the
documentation or on-screen help that came with your computer for more
information on managing memory.
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6 Double-click the icon of the image you want to see.

The image appears in a TeachText or SimpleText window. (You can choose to
have Photo CD images opened by another program. See “Setting Preferences
for How Photo CD Images Are Displayed” later in this chapter).

You can view and print the image, or paste it into your Scrapbook or into a
document created by another program that can handle graphics.

IMPORTANT  You can’t rename or change the Photo CD images on the CD-
ROM disc. To rename or change an image, you first need to copy it to a hard
disk or floppy disk.
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Viewing several images in sequence

You can browse through all your Photo CD images using the Slide Show and
the Slide Show Viewer in the Photo CD window. The Slide Show is a
QuickTime movie of all your Photo CD images.

To play the Slide Show: 

1 Insert a Photo CD and open the Photo CD window.

2 Double-click the Slide Show icon.

The Slide Show Viewer automatically begins displaying Photo CD images.

3 Use the Slide Show Viewer controls to stop or start the slide show, scroll to particular
images, or move forward or backward through the images.

You can also go directly to an image by typing its number.
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Setting preferences for how Photo CD images are displayed

You can control how Photo CD images are displayed by using the Preferences
command in the Slide Show Viewer. You can choose

m which program will automatically open Photo CD images

m which resolution is used

m the size of the Slide Show window

To set your preferences for viewing Photo CD images:

1 Double-click the Slide Show Viewer icon to open it.

2 Choose Preferences from the File menu.

The Preferences dialog box appears. 

IMPORTANT  You may see an error message when you choose a program for
opening Photo CD images. The message indicates that you can’t open an
image in this program by double-clicking the image. However, you may be
able to open an image from within the program, using its Open command.
(See the documentation that came with your program for more information.)

3 After you’ve chosen the options you want, click OK to close the Preferences dialog box. 

4 Restart your Macintosh.

After you restart your Macintosh, double-clicking a Photo CD image will
open it in the selected program at the specified resolution and size.
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A note about resolution

When a Photo CD image is created, it’s recorded at five different levels of
resolution. The higher the resolution, the more information is recorded about
the image, and the sharper the image appears when displayed or printed at
larger sizes. However, high-resolution images take up a lot of memory—up to
18 MB of data for one photograph—which affects file size, as well as the
amount of time it takes to display or print an image.

It’s best to work with a resolution appropriate for your monitor or printer.
Some monitors and printers cannot display or print very high-resolution
images. 

For most work, a resolution of 768 x 512 pixels or smaller is suitable. For
detailed work or very high-quality reproductions, you may want to use a
higher resolution.

Make sure to open high-resolution images with application programs designed
to handle large image files. TeachText and SimpleText cannot open very large
files. 

Working with Photo CD images in other programs 

There are several ways to open and work with Photo CD images in other
programs:

m You can choose a program that automatically opens a Photo CD image
when you double-click it. See “Setting Preferences for How Photo CD
Images Are Displayed,” earlier in this chapter.

m From the Slide Show Viewer, you can transfer a displayed image directly to
another program, without copying and pasting. See the next section,
“Transferring the Displayed Image to Another Program.”

m You can copy and paste an image. See “Copying Images From a Slide
Show” later in this chapter.

Once you’ve opened an image in a program, you can change the image and
save your changes on a hard disk or floppy disk. (The images on the Photo
CD cannot be changed.)
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Transferring the displayed image to another program

You can transfer an image from the Slide Show Viewer into another program,
using the current Preferences settings or using different settings.

To transfer an image using the current settings in the Preferences dialog box:

m Display the image you want, then choose View from the Photos menu (or
double-click the image).

The image opens in the program and resolution you specified in the
Preferences dialog box.

To transfer the image using different settings:

1 Display the image you want, then choose View As from the Photos menu.

2 In the dialog box that appears, choose a resolution from the Size pop-up menu.

3 From the Using pop-up menu, choose a program to open the image.

If the program you want is not in the pop-up menu, click Add. In the dialog
box that appears, locate and select the program you want to add.

4 When you’ve chosen the options you want, click OK.

The image opens in the program and at the resolution you specified.

Copying images from a Slide Show 

You can paste a Slide Show image into any document that accepts images.

To paste an image at the resolution specified in the Preferences dialog box:

1 Display the image you want to copy, then choose Copy from the Edit menu.

2 Open the document you want to paste the image into.
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3 Choose Paste from the Edit menu.

The image appears in your document.

To paste the image at a different resolution:

1 Display the image you want to copy, then choose Copy As from the Edit menu.

2 In the dialog box that appears, choose a resolution from the Size pop-up menu.

3 Click OK.

4 Open the document you want to paste the image into.

5 Choose Paste from the Edit menu.

The image appears in your document.

Copying a Slide Show onto another disk

You can copy the Slide Show to a hard disk or floppy disk. 

IMPORTANT  You can’t copy a Slide Show by dragging its icon. The icon will
be copied, but you won’t be able to use it to view the Slide Show.

To copy the Slide Show:

1 Double-click the Slide Show icon to open it.

2 Choose Save a Copy from the File menu.

The Compression Settings dialog box appears.

3 Select the options you want.

You can copy either color or grayscale images. You can also specify a
compression method and choose the quality of the copy.

4 Click OK.

A dialog box appears.

5 Choose a location and type a name for the copy, then click Save.

You can now open your disk copy to view the Slide Show.
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In most cases, all the software required for using your CD-ROM player,
including QuickTime software, is already installed on your computer and
ready to use. Follow the instructions in this chapter only if you need to install
or reinstall the software. 

To determine whether your software is installed, see “Is Your CD-ROM
Software Already Installed?” in Chapter 1.

Before you start:  Check the user’s guide that came with your computer (or if
you are a system administrator, check the administrator’s guide that came with
your server). If it contains instructions on reinstalling CD-ROM software, use
those instructions instead of the instructions in this chapter.

Locating the CD-ROM software

If you purchased your computer with a CD-ROM player built in, your CD-
ROM software is on the system software CD-ROM disc that came with your
computer. See “Installing CD-ROM Software using a System Software Disc,”
later in this chapter.

If you added this CD-ROM player after you purchased your computer, your
CD-ROM software is on a CD-ROM disc called CD-ROM Setup. See the next
section, “Installing CD-ROM Software Using the CD-ROM Setup Disc.”

29

4 Reinstalling the CD-ROM Software



Installing CD-ROM software using the CD-ROM Setup disc

To install the CD-ROM software, follow these steps:

1 Shut down your Macintosh.

2 Insert the CD-ROM Setup disc, then start up your Macintosh while holding down the
x-Option-Shift-Delete keys on your keyboard.

By holding down the keys, you force the computer to bypass the internal hard
disk and to start up from the CD-ROM disc. In a few moments, the disc icon
appears on your screen.

3 Double-click the disc icon to open it.

4 Double-click the Installer icon to open it.

The Install dialog box appears.

5 Make sure the name of your startup disk is shown in the box. If not, click Switch Disk
until the correct disk name appears. 

Your startup disk is the disk whose icon usually appears in the upper-right
corner of your screen.
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6 Click Install. 

The CD-ROM and QuickTime software is automatically placed in the System
Folder on the selected hard disk. 

7 When you see a message reporting that installation was successful, click Restart.

Your CD-ROM software has been installed. (If a message reports that
installation was not successful, follow the instructions on screen to try
installing the software again.)

Installing CD-ROM software using a system software disc

If you are installing CD-ROM software from the system software disc that
came with your computer, you can choose to install either the CD-ROM
software, the QuickTime software, or both. You cannot choose to install
individual CD-ROM software files. Follow these steps:

1 Shut down your Macintosh.

2 Insert the system software CD-ROM disc and start up the Macintosh, while holding down
the x-Option-Shift-Delete keys on your keyboard.

By holding down these keys, you force the computer to bypass the internal
hard disk and to start up from the CD-ROM disc. In a few moments, the disc
icon appears on your screen.

3 Double-click the disc icon to open it.

4 Locate the Installer icon on the disc.

5 Double-click the Installer icon to open it.

The Easy Install dialog box appears.
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. 6 Choose Custom Install from the pop-up menu.

Your installation choices appear.

7 Click the triangle next to Multimedia Software so that it points down.

The choices for multimedia software appear. Your list may look different from
the one shown here.

8 Click the checkboxes next to CD-ROM, QuickTime, or both. 

Click both boxes if you want to install all the software. (To view Photo CDs
and some other CD-ROM information, you need to install QuickTime.)

9 Make sure the name of your startup disk is shown in the box. If not, click Switch Disk
until the correct disk name appears. 

Your startup disk is the disk whose icon usually appears in the upper-right
corner of your screen.

10 Click Install.

The software you selected is installed in the System Folder on the selected
hard disk. 

11 When you see a message reporting that installation was successful, click Restart.

Your CD-ROM software has been installed. (If a message reports that
installation was not successful, follow the instructions on screen to try
installing the software again.)
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This chapter describes solutions to problems you may encounter while using
your CD-ROM player.

Many problems can be caused by improper installation of the CD-ROM
software. If you have to reinstall the software, make sure you install it exactly
as described in Chapter 4.

If the suggestions in this chapter don’t solve your problem, refer to the service
and support information that came with your computer for information on
obtaining technical assistance.

Problems starting up your computer

The computer doesn’t seem to know that there is an internal CD-ROM player.

m Make sure the CD-ROM software that came with your CD-ROM player 
is installed. (See “Is Your CD-ROM Software Already Installed?” in
Chapter 1.)

m Make sure to restart your computer after you reinstall the CD-ROM
software.

m If you have other SCSI devices attached to your computer, make sure that 
each device has a unique SCSI ID number (your CD-ROM player has 
SCSI ID 3). Refer to the documentation that came with your SCSI devices
if you need to reset SCSI ID numbers.
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The computer won’t restart after you’ve copied software for your CD-ROM player to the
System Folder.

m If you attempt to install software for your CD-ROM player without using
the Installer, you may not be able to restart your computer. Restart the
computer with the Shift key held down (to turn off system extensions), then
remove any CD-ROM software files you copied by dragging them to the
Trash. Reinstall the software according to the instructions in Chapter 4. 

If using the Shift key doesn’t work, restart the computer using another
startup disk. (For instructions, see the documentation or on-screen help
that came with your computer.)

Your computer won’t restart, and a CD-ROM disc is inside the CD-ROM player.

m Your computer may be trying to start up from the CD-ROM disc. Press the
Open/Close button on the front of the computer to open the tray, and
remove the CD-ROM disc. Then restart your computer.

When your computer starts up, you see large folder-shaped areas, containing labeled
pictorial buttons, instead of the usual Macintosh desktop.

m Your computer may have started up from a CD-ROM disc containing 
At Ease, an alternative to the Macintosh desktop. 

To return to the Macintosh desktop, choose Shut Down from the Special
menu. When your computer is off, press the Open/Close button for your
CD-ROM player to open the tray, then remove the CD. Close the tray. Then
start up your computer again.

To avoid having the computer start up from a CD-ROM disc, remember to
remove any disc in the player before you shut down your computer.

Problems using CD-ROM discs

The tray of your CD-ROM player won’t open.

If a CD-ROM disc icon appears on your screen:

Drag the disc icon to the Trash, or select it and choose Put Away from the
File menu. If the AppleCD Audio Player is active, choose Eject CD from 
the File menu. (If you’re using a multivolume CD, you must put away all the
CD icons to open the tray.)
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If you see a message that a disc can’t be put away because it is being shared,
turn off file sharing, then try again to put away the disc. (See your computer’s
documentation or on-screen help for information on file sharing.)

If no CD-ROM disc icon appears on your screen:

m Press the Open/Close button for your CD-ROM player (located on the
computer’s front panel).

m The signal to open the tray may not be reaching the computer. Turn off
your computer and locate the small pinhole to the lower right of the 
CD-ROM tray opening. Insert the end of a large straightened paper clip
horizontally into the pinhole. Push gently but firmly until the tray is
released, then carefully pull the tray open. Do not force the tray open; wait
until the paper clip has dislodged it, or you may break the front of the tray.

m If neither of these suggestions works, your CD-ROM player may be
damaged. Contact an Apple-authorized service provider or Apple for
further assistance.

You insert a CD-ROM disc, but its icon doesn’t appear on the Macintosh desktop. 

m Make sure the disc label is facing up and the disc is centered in the tray. If
you’re using a small (8 cm) disc, make sure it is within the tray’s inner ring.

m Make sure the tray is closed all the way.

m Make sure the CD-ROM software is installed. (See “Is Your CD-ROM
Software Already Installed?” in Chapter 1.)

m Try restarting your computer.

See also the suggestions in “Problems Starting Up Your Computer,” earlier in
this chapter.

Your computer displays the message “This is not a Macintosh disk: Do you want to
initialize it?” when you insert a CD-ROM disc. 

m Make sure the CD-ROM software is installed. (See “Is Your CD-ROM
Software Already Installed?” in Chapter 1.)

m Turn off any utilities that allow you to use disks in non-Macintosh formats.

WARNING  Turn off your computer before you attempt to open the tray
using a paper clip. If you don’t, you may damage the CD-ROM player.
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m The disc may use an information format (mode) that the Macintosh cannot
recognize. (See the section on modes in the Appendix.)

Your computer ejects a CD-ROM disc without giving you any error message. 

m Make sure the disc is flat in the tray and the disc label is facing up. If
you’re using a small (8 cm) disc, make sure it’s centered within the tray’s
inner ring. 

m The disc may need to be cleaned. (See “Care and Handling” in Chapter 1.)
If there are visible scratches on the shiny side of the disc, you may be able
to remove them with a CD polishing kit (available from your audio CD
dealer). If the scratches can’t be removed, you’ll need to replace the disc. 

m The disc may be damaged. Try another disc in your CD-ROM player, or try
the problematic disc in another player. If the original player reads other
discs, or if the problematic disc doesn’t work in another player, the disc is
probably damaged. You’ll need to replace the disc.

You can’t open a document on a CD-ROM disc.

m Try opening the application program first; then open the document.

m Consult the documentation that came with your disc. Some discs come
with software that you need to install on your computer before using them.

You can’t save changes you make to information on a CD-ROM disc. 

m CD-ROM is a read-only medium. This means that information can be read
(retrieved) from it, but not written (stored) on it. You can save the changed
information on a hard disk or floppy disk. 

Problems using ISO 9660 or High Sierra discs

You cannot access files on a CD-ROM disc that uses the ISO 9660 or High Sierra format.

m Discs in the ISO 9660 and High Sierra formats have version numbers
attached to filenames. Some application programs need the version
numbers in order to work with files. To make the version numbers
available to programs on your computer, follow these instructions:

Drag the disc icon to the Trash. After the tray opens, hold down the Option
key and close the tray. Continue to hold down the Option key until the tray
is completely closed. The program you are using should now be able to
locate filenames on the disc.
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Problems playing audio CDs

You don’t hear any sound when you play an audio CD or an audio track on a CD-ROM
disc using the AppleCD Audio Player.

m If you have headphones or speakers connected to the computer, make sure
they are firmly connected. Make sure the volume control on your
headphones or speakers is not turned down too low.

m If you do not have headphones or speakers connected, make sure that
nothing else is plugged into the sound output port on your computer.

m You may need to reset the sound options using the Sound control panel.
From the pop-up menu in the panel’s upper-left corner, choose Sound In,
and make sure that Built-in is selected as the audio source. Then click
Options and make sure Internal CD and Playthrough are selected. (See
your computer’s documentation or on-screen help for more information.)

m If you are using a CD-ROM disc over a network, you won’t be able to hear
the audio portion.

m Make sure the volume is turned up in the AppleCD Audio Player. With the
Audio Player open, drag the volume control slider up or press the Up
Arrow key on your keyboard.

m The CD may be paused. With the Audio Player open, click the Play/Pause
button or press the Space bar on your keyboard. 

While playing an audio track on a CD-ROM disc that combines audio tracks and data,
you double-click the disc icon and the audio track stops playing.

m You can’t open files on a CD-ROM disc and listen to audio tracks on that
disc at the same time.

You are unable to record sound from an audio CD.

m Check your computer’s sound input port to see if a microphone or other
equipment is connected. Some older models cannot record from an
internal CD-ROM player if a device is connected to the sound input port.

m You may need to reset the sound options using the Sound control panel.
Choose Sound In from the pop-up menu in the upper-left corner, and make
sure Built-in is selected as the audio source. Click Options and make sure
Internal CD and Playthrough are selected. See the documentation or on-
screen help that came with your computer for more information.
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Problems using Photo CDs

Your CD-ROM player will not open Photo CDs.

m To view Photo CD images, you must have QuickTime (version 1.6.1 or later)
and Apple Photo Access installed in your System Folder. Both files are
part of the CD-ROM software. For information on installing the CD-ROM
software, see Chapter 4.

Your computer does not display color icons for Photo CD documents.

m Your system may be low on memory. Restart your computer, then reopen
the Photos folder. See your computer’s documentation or on-screen help
for more information on managing memory.

A Photo CD image is scrambled, colors are displayed incorrectly, or no image appears.

m The program you’re using may not be able to work with large (high-
resolution) image files. Try opening a lower-resolution image, opening the
image with another program (see “Setting Preferences for How Photo CD
Images are Displayed” in Chapter 3), or assigning more memory to the
program (see your computer’s documentation or on-screen help).

After you open a Photo CD image, your system “freezes” and does not respond to any
input, or a “bomb” message appears on your screen.

m Restart your Macintosh. The program you’re using may not be able to work
with large (high-resolution) image files. Try opening a lower-resolution
image, opening the image with another program (see “Setting Preferences
for  How Photo CD Images are Displayed” in Chapter 3), or assigning the
program more memory (see your computer’s documentation or on-screen
help).

WARNING  If you have a problem with your CD-ROM player and nothing
presented in this chapter solves it, consult the service and support
information that came with your Apple product for instructions on how
to contact an Apple-authorized service provider or Apple for assistance.
If you attempt to perform upgrades or repairs yourself, any damage you
may cause to your equipment will not be covered by the limited
warranty on your equipment. Contact an Apple-authorized dealer or
service provider for information about this or any other warranty
question.
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Disc
m Data surfaces 1

m Disc diameter 120 millimeters (mm) and 80 mm

m Disc center hole diameter 15 mm

m Thickness 1.2 mm

m Track pitch 1.6 microns (15,875 tracks per inch)

m Scanning velocity 1.2–1.4 meters per second

m Rotation speed Varies over radius

Normal speed ~530 to 230 revolutions per minute
(rpm)

Double speed ~1060 to 460 rpm

Quadruple speed ~2120 to 920 rpm

m Latency (average) Varies over radius

Normal speed ~55 to 130 milliseconds (ms)

Double speed ~27.5 to 65 ms

Quadruple speed ~13.75 to 32.5 ms
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m Blocks per rotation ~8.4 to 19.5 variable

m Average access time (typical)

Normal speed 380 ms

Double speed 270 ms

Quadruple speed 200 ms

Data
m Data capacity 656 megabytes (MB), Mode 1

748 MB, Mode 2

m Number of blocks per disc 336,150

m Data per block 2048 bytes, Mode 1

2336 bytes, Mode 2

m Address description Minutes, seconds, blocks

Audio capacity
m Playing time 74 minutes and 42 seconds

Modes supported
m Audio CD

m CD-ROM Modes 1 and 2

m CD-ROM XA Mode 2, Forms 1 and 2

m CD-I Mode 2, Forms 1 and 2

m Photo CD Single session and multisession

m Video CD

Data streaming and transfer rates
m Blocks per second

Normal speed 75 

Double speed 150 

Quadruple speed 300 
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m User kilobytes (K) per second

Normal speed 150K, Mode 1

171.1K, Mode 2

Double speed 300K, Mode 1

342.2K, Mode 2

Quadruple speed 600K, Mode 1

684.4K, Mode 2

m SCSI bus burst rate (typical)

Asynchronous 5.0 MB per second

Synchronous 5.0 MB per second

Environmental

Noise (maximum)

m Drive on (seek) < 50 decibels (dB) 

m Drive on (nonseek) < 46 dB

m Tray open/close < 55 dB

Temperature 

Celsius (C) and Fahrenheit (F)

m Operating temperature 5° to 55° C (41° to 131° F)

m Storage (6 months) –30° to 50° C (–22° to 122° F)

m Transient (72 hours) –40° to 65° C (–40° to 149° F)

Humidity

m Operating 5% to 90% noncondensing

m Storage 5% to 95% noncondensing
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Altitude

Meters (m) and feet (ft.)

m Operating –305 to 3,048 m

(–1,000 to 10,000 ft.)

m Shipping, non-operating –305 to 15,240 m 

(–1,000 to 50,000 ft.)

Power requirements

m Voltage +5 V DC ± 5%

+12 V DC ± 10%

Power consumption (typical)

m +5 V DC 360 milliamperes (mA)

m +12 V DC 620 mA

Laser

Type

m Semiconductor GaAlAs laser

Wavelength

m 790 ± 25 nanometers

Output power

m 0.2–0.6 milliwatts

Beam divergence

m 55°
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